## Contents

1. Copyright Notice ........................................................................................................................................... 4

2. Introduction.............................................................................................................................................................................................. 6
   2.1 About Studio ................................................................................................................................................ 6
   2.2 Workflow and Concepts ............................................................................................................................................ 7
   2.3 Quick-Start Tutorial .................................................................................................................................................. 8

3. Creating a New Bag ............................................................................................................................................................................ 12
   3.1 Pillow Bags .......................................................................................................................................................... 13
       3.1.1 Panel Order and Fin vs. Lap Seals ........................................................................................................... 14
   3.2 Gusseted Bags ...................................................................................................................................................... 15
       3.2.1 Open or Closed Gussets .......................................................................................................................... 16
   3.3 Stand-up Pouches .................................................................................................................................................. 17
       3.3.1 Stand-Up Pouch without Bottom Seal .................................................................................................. 18
   3.4 Tetrahedral Bags .................................................................................................................................................. 19
   3.5 Quattro Seal Bags ................................................................................................................................................ 21
       3.5.1 Seals for Quattro Seal Bags .................................................................................................................. 22
   3.6 Quattro Seal Bag with Back Seal .................................................................................................................... 24
   3.7 Sachets ............................................................................................................................................................. 25
       3.7.1 Sachet Type and Orientation ............................................................................................................... 27
   3.8 Diaper Bags ...................................................................................................................................................... 29
   3.9 Ponytail Bag ..................................................................................................................................................... 30

4. Changing the appearance of the bag ............................................................................................................................... 33
   4.1 Put an Object inside the Package ...................................................................................................................... 33
   4.2 Tweaking the Substrate shading ......................................................................................................................... 35
   4.3 Setting the Rounding Value ......................................................................................................................................... 36

5. Live Shaping .................................................................................................................................................................................. 38
   5.1 Starting and Stopping Live Shaping ..................................................................................................................... 38
   5.2 Live Shaping and Done/Stalled ......................................................................................................................... 38
   5.3 Air and Liquid Content ........................................................................................................................................... 39
   5.4 Setting the Stiffness Value ........................................................................................................................................... 40
   5.5 Working with Pullers ................................................................................................................................................ 40
       5.5.1 Creating and Changing Pullers .............................................................................................................. 40
       5.5.2 Deleting Pullers .......................................................................................................................................... 42
   5.6 Working with Fold Lines ......................................................................................................................................... 43
       5.6.1 Fixed Fold Lines .......................................................................................................................................... 43
       5.6.2 Creating Custom Fold Lines .................................................................................................................. 43
       5.6.3 Deleting Custom Fold Lines ................................................................................................................ 44
       5.6.4 Hard and Soft Fold Lines ....................................................................................................................... 44
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.6.5</td>
<td>Limitations</td>
</tr>
<tr>
<td>5.6.6</td>
<td>Using parallel Fold Lines to make a smooth bend</td>
</tr>
<tr>
<td>5.7</td>
<td>Working with the Polygon Mesh</td>
</tr>
<tr>
<td>5.7.1</td>
<td>Using the Mesh tool</td>
</tr>
<tr>
<td>5.7.2</td>
<td>Reset the Mesh</td>
</tr>
<tr>
<td>5.8</td>
<td>Working with the Freeze tool</td>
</tr>
<tr>
<td>6.1</td>
<td>Saving and opening Collada files</td>
</tr>
<tr>
<td>6.2</td>
<td>Import Into</td>
</tr>
<tr>
<td>6.2.1</td>
<td>Obtain a 3D shape</td>
</tr>
<tr>
<td>6.2.2</td>
<td>Using graphic files</td>
</tr>
<tr>
<td>6.3</td>
<td>Change the Camera viewpoint</td>
</tr>
<tr>
<td>6.4</td>
<td>Transform the selected 3D shape(s)</td>
</tr>
<tr>
<td>6.5</td>
<td>Repeat</td>
</tr>
<tr>
<td>6.6</td>
<td>Selecting objects</td>
</tr>
<tr>
<td>6.7</td>
<td>Tabs</td>
</tr>
<tr>
<td>6.8</td>
<td>Measurements</td>
</tr>
<tr>
<td>6.8.1</td>
<td>Adding measurements</td>
</tr>
<tr>
<td>6.8.2</td>
<td>Setting up measurements</td>
</tr>
<tr>
<td>6.8.3</td>
<td>Slant measurements</td>
</tr>
<tr>
<td>6.9</td>
<td>Preferences</td>
</tr>
</tbody>
</table>
1. Copyright Notice

© Copyright 2015 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the property of Esko Software BVBA. The material, information and instructions are provided on an AS IS basis without warranty of any kind. There are no warranties granted or extended by this document. Furthermore Esko Software BVBA does not warrant, guarantee or make any representations regarding the use, or the results of the use of the software or the information contained herein. Esko Software BVBA shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a database or retrieval system, or published, in any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE®, PantoneLIVE and other Pantone trademarks are the property of Pantone LLC. All other trademarks or registered trademarks are the property of their respective owners. Pantone is a wholly owned subsidiary of X-Rite, Incorporated. © Pantone LLC, 2014. All rights reserved.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights reserved.
The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm. Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems in the U.S. and other countries.

Part of this software uses technology by BestTM Color Technology (EFI). EFI and Bestcolor are registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Office.


All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BVBA
Kortrijksesteenweg 1095
B – 9051 Gent
info.eur@esko.com
2. Introduction

**Important note**

The **Studio Toolkit** application is a standalone application allowing to import, edit and create 3D objects, and save the object(s) as Collada file.

**Note:** If you want to use a bag created in Studio Toolkit for Flexibles into the Studio Toolkit application (e.g. to create a repeat or a combination of different objects), you need to keep in mind that this version of Studio Toolkit only imports Collada files, while Studio Toolkit for Flexibles exports .bag files. You can however open a bag file in Studio Designer, and save it as a collada file there.

### 2.1 About Studio

Studio is a unique set of tools for 3D packaging design made specifically for packaging artwork professionals.

Working in 3D for packaging typically consists of 3 steps: first you create a shape or "structure". Next you apply artwork to that shape. And finally you present the result as an image, movie, etc.

To achieve this, Studio has different modules (shown as purple rectangles in the image underneath). It takes you through different software applications, such as Adobe Illustrator and the Studio Toolkit.

**Step 1: Create a Structure**

The first step is to prepare a 3D packaging shape, with a matching 2D key line template. This shape can come from one of the Studio Toolkits, from ArtiosCAD or from Esko’s Shape server.

The **Studio Toolkits** allow to create or modify structural design files for a specific use or workflow. Every Studio Toolkit consists of an Adobe Illustrator plugin and/or specific functionality inside the
**Studio Toolkit** application. The Studio Toolkit application allows to import, create, modify or combine shapes, and save the result as a collada file.

- With the **Studio Toolkit for Boxes** plugin you can clean up die-drawings of boxes, and fold them into a 3D shape.

- You can use the **Studio Toolkit for Flexibles** functions in the Studio Toolkit application to create 3D models of flexible packaging.

- With the **Studio Toolkit for Labels** plugin, you can create round objects with one or more labels, and automatically warp artwork for conical labels. With the Studio Toolkit for Labels functions in the Studio Toolkit applications, you can draw labels on existing shapes.

- With **Studio Toolkit for Shrink Sleeves** in the Studio Toolkit application you can create a heat shrink sleeve around one or more shapes, and simulate the distortion. Using the Studio Toolkit for Shrink Sleeves plugin, you can apply counter distortion to your artwork.

**Step 2: Apply Artwork**

The second step is to make sure the production artwork fits to the structure.

In Adobe Illustrator, ArtPro or PackEdge, you can use **Studio Designer** to get a preview of the 3D object with its artwork, check every detail, and fix specific issues.

With **Studio Visualizer** you can simulate print substrates and a wide range of print and finishing effects.

**Step 3: Share**

You can share your 3D design using the Studio Viewer or Webcenter, or use your 3D design in Store Visualizer.

In Studio Designer and Visualizer, you can export your 3D designs to share realistic virtual packaging mock-ups as movies, images or interactive 3D.

### 2.2 Workflow and Concepts

**About Studio Toolkit for Flexibles**

Studio Toolkit is an application that runs on Mac OS or on Windows, and allows you to design and create flexible packages like potato chips bags, candy bar wrappers, stand-up pouches and diaper bags, to name but a few of the many possibilities.

The design will be saved to a Collada file, and this file can then be imported in Adobe® Illustrator®, or in specialized Esko editors such as ArtPro, PackEdge or Visualizer.

**Using the collada file in Studio Designer**

Once a .bag file is placed in an Illustrator, ArtPro or PackEdge document, the Studio window can display a three-dimensional preview of the packaging with the Illustrator/ArtPro/PackEdge artwork rendered on it. This allows you to see how the graphics will look on the final bag. Studio also contains productive tools for quick and accurate aligning.

With Studio you can export the 3D design to various file formats such as 3D PDF for interactive viewing or a TIFF rendering to use in ads.
Using the collada file in Visualizer

Placing the Collada file in Visualizer allows you to render special finishes, such as foils or varnishes on the 3D design. The rendered images can be exported to QuickTime movies or to a wide variety of image formats that can be used in advertising.

2.3 Quick-Start Tutorial

As an introduction exercise, we will explain how you can make a 3D PDF of a simple pillow bag. We assume you have Studio Toolkit for Flexibles, Adobe Illustrator and Studio for Adobe Illustrator installed.

1. Start Studio Toolkit.
2. Click the New Bag button
3. Select the Pillow Bag type and click OK.

A bag will be shown in 3D, using the default dimensions, and some basic Live shaping is applied. The Bag tab contains the 2D foldout layout of the pillow.
4. You can apply **Live Shaping** but we will skip this step for now. Click **File > Save** and save the bag as a Collada file.

5. Start Adobe® Illustrator® and open the saved file. If you have the latest version of Studio installed, you can open the files in Illustrator. Illustrator will show you a document with a locked layer that contains the keylines. This is the foldout layout of the pillow bag that we just made. The biggest rectangle in the center is the front face of the bag.

6. Open the Studio Window: Choose **Window > Esko > Studio Designer > Show Studio**. The bag shape created in **Studio Toolkit** will appear. Click and drag the mouse to rotate it. Use Adobe® Illustrator® to create the graphic artwork for the bag.

7. Click the update button in the bottom left corner of the Studio Window to render the graphics preview on top of the 3D visualization of your bag or choose **Window > Esko > Studio Designer > Refresh Studio**.

   The shortcut key to activate the tool is **Cmd+Option+6** or **Ctrl+Alt+6**.
Tip:
Click the fly-out menu button to gain quick access to important functionality such as exporting to 3D PDF.

8. On the fly-out menu, choose **Export...**

9. Choose **PDF File with 3D Design** as file type and click **Save As...**
10. After exporting, open the resulting PDF file in Adobe® Reader® 8 or Adobe® Acrobat® and use the 3D tools to rotate, zoom,...
3. Creating a New Bag

1. Click the New Bag button to create a new flexible bag.

2. Select a bag type and click Ok.
   A bag of the selected type will be created, using default settings. A 2D tab containing the 2D die is added.
   If the bag is selected, all parameters can be changed in the right panel.

   **Note:**
   When creating or changing a bag, some initial Live Shaping will be applied to the 3D bag.
3.1 Pillow Bags

A pillow bag is a simple flexible bag with a top and bottom seal, and a centered or off-center vertical backseal. The most common examples of pillow bags are potato chips bags and certain candy bar wrappers.
Settings:

- Dimensions: Width, Length Top Seal and Bottom Seal

- Back Seal: Size, Type (Fin Seal or Lap Seal), Order, and Position. See Panel Order and Fin vs. Lap Seals on page 14

- Package Content. See Put an Object inside the Package on page 33

- Appearance: Highlights, Rounding. See Tweaking the Substrate shading on page 35 and Setting the Rounding Value on page 36

3.1.1 Panel Order and Fin vs. Lap Seals
A back seal can be folded (Fin Seal) or glued (Lap Seal) to the back side of the package in two ways: Left over Right or Right over Left. Depending on the selection, the image of the seal will be adjusted.

For Gusseted, Pillow and Quattro Seal bags with a Back Seal, you can specify the Position of the back seal: select Centered to center the back seal on the back panel, or disable Centered and provide an offset value in the field below that option.

In Studio Toolkit for Flexibles 14 and newer, the back seal can overlap the gusset.

Note:
The offset value in the Position field is the width of the left or right back flap, whichever is on top as specified in the Order list (Left over Right or Right over Left). In other words, if the Order is set to Left over Right, the Position value you type is the width of the Left back flap.

3.2 Gusseted Bags

A gusseted bag is a more complex flexible bag with top, bottom and back seals and gussets at both sides. The gussets allow the bag to make a more block-like shape. Just like pillow bags, Studio Toolkit supports back seals that are either centered or off-center at the back. For gusseted bags, you can also choose whether you want an open or a closed (glued) gusset.
Settings:

- Dimensions: Width, Length, depth
- Seals: Top Seal & Bottom Seal, Open or Closed Gusset. See Open or Closed Gussets on page 16
- Back Seal: Size, Type (Fin Seal or Lap Seal), Order, and Position. See Panel Order and Fin vs. Lap Seals on page 14
- Package Content. See Put an Object inside the Package on page 33
- Appearance: Highlights, Rounding. See Tweaking the Substrate shading on page 35 and Setting the Rounding Value on page 36

3.2.1 Open or Closed Gussets

For gusseted and quattro seal bags, you can specify whether you want to have Open Gussets for the top and/or bottom gussets.
Note: For pouches you can only choose to have open or closed bottom gussets.

3.3 Stand-up Pouches

A stand-up pouch is a flexible bag with top, left, right and optional bottom seals, with a gusset in the bottom part but not in the top part. You can specify an open or a closed (glued) gusset.

Currently, only pouches in one piece are supported, meaning that the bottom is part of the complete package. Studio Toolkit for Flexibles only supports rectangular pouches.

Tip:
You can also create a pouch without bottom seals. Simply set the bottom seal value to 0mm/inches.
Settings:

- Dimensions: Width, Length, depth
- Seals: Top Seal, Bottom Seal and Side Seal. Open or Closed Gusset. See Open or Closed Gussets on page 16
- Appearance: Highlights, Rounding. See Tweaking the Substrate shading on page 35 and Setting the Rounding Value on page 36

3.3.1 Stand-Up Pouch without Bottom Seal

You can create a stand-up pouch with no bottom seal by setting the Bottom Seal value to 0mm/inch.
3.4 Tetrahedral Bags

The Tetrahedral Bag is a special version of the Pillow Bag. The difference is that for a Tetrahedral bag, the top and bottom seals are turned 90 degrees towards each other. This technique produces the typical tetrahedral bag.
Because of its shape, it is not so obvious to see the connection between the 3D and 2D view. This is an example Tetrahedral Bag in 3D:

And the corresponding 2D view:
Settings:

- Dimensions: Width, Length
- Seals: Top Seal and Bottom Seal
- Back Seal: Size, Order, and Position. The Back Seal is always a lap seal. See Panel Order and Fin vs. Lap Seals on page 14
- Appearance: Highlights, Rounding. See Tweaking the Substrate shading on page 35 and Setting the Rounding Value on page 36

Note: You can use the Move and Rotate... tools to put the bag on its side. See Transform the selected 3D shape(s) on page 54

3.5 Quattro Seal Bags

Like the gusseted bag, the quattro seal bag is a complex flexible bag with top and bottom seal and gussets at both sides. The gussets can be open (unglued) or closed (glued) near the top and/or bottom seals.

Different from the gusseted bag, the quattro seal bag also has four vertical side seals. Studio Toolkit also supports the version without any side seals: simply set the side seals value in the application to 0mm/inch.

Common for a quattro seal bag is the fact that the (back) seal is "hidden" in one of the four corners of the bag. A quattro seal bag can have a tapered or square bottom and/or top. This bag type is commonly used for products such as coffee pads, cookies and animal food.
Settings:

- Dimensions: Width, Length, depth

- Seals: Top Seal, Bottom Seal and Side Seal, Open or Closed Gusset. See **Open or Closed Gussets** on page 16.

- The Join position: see **Seals for Quattro Seal Bags** on page 22

- Style: Tapered or Square. See **Seals for Quattro Seal Bags** on page 22

- Package Content. See **Put an Object inside the Package** on page 33

- Appearance: Highlights, Rounding. See **Tweaking the Substrate shading** on page 35 and **Setting the Rounding Value** on page 36

### 3.5.1 Seals for Quattro Seal Bags

You can create a quattro seal bag **without side seals** by setting the **Side Seals** value to 0 mm/inch
The **Back Seal** for quattro seal bags is hidden in one of the four corners of the bag. The **Join** setting in Studio Toolkit for Flexibles allows you to specify whether the back seal is hidden in the back left or the back right corner of the bag.

Quattro seal bags can have a **tapered or square top and/or bottom**.
3.6 Quattro Seal Bag with Back Seal

The Quattro Seal Bag with Back Seal is a special version of the Quattro Seal Bag. See Quattro Seal Bags on page 21
The **Quattro Seal Bag with Back Seal** is identical to the **Quattro Seal Bag** but has a seal on the back of the bag, instead of a "hidden" back seal in one of the four corners.

Studio Toolkit also supports the version without any side seals: simply set the side seal values in the application to 0 mm or inch.

A **Quattro Seal Bag with Back Seal** can have a tapered or square bottom and/or top.

**Settings:**

- **Dimensions:** Width, Length, depth
- **Seals:** Top Seal, Bottom Seal and Side Seal, Open or Closed Gusset. See *Open or Closed Gussets* on page 16.
- **Back Seal:** Size, Type (Fin Seal or Lap Seal), Order, and Position. See *Panel Order and Fin vs. Lap Seals* on page 14
- **Style:** Tapered or Square. See *Seals for Quattro Seal Bags* on page 22
- **Package Content:** See *Put an Object inside the Package* on page 33
- **Appearance:** Highlights, Rounding. See *Tweaking the Substrate shading* on page 35 and *Setting the Rounding Value* on page 36

### 3.7 Sachets

A sachet is a simple flexible bag type with three seals and a fold, or with four seals:
• For three-seal sachets, Studio Toolkit lets you choose whether the fold is at the top, right, bottom, or left side of the sachet.

• For four-seal sachets, you can only change the orientation of the die shape, either horizontally aligned front and back or vertically.

The sachet bag type is commonly used for powder products like dried herbal mixes, instant soup, baking powders,...

A four-seal sachet, sealed along the four sides:

A three-seal sachet with a fold at the bottom and seals along the left, right and top sides:
3.7.1 Sachet Type and Orientation

Studio Toolkit for Flexibles supports both three-seal sachets with a fold and three seals, and four-seal sachets.

If you have specified a three-seal sachet with a fold, Studio Toolkit for Flexibles allows you to choose where you want the fold to appear (left, right, top or bottom).
If you chose a sachet with four seals, the orientation has no effect on the 3D representation, because there is no fold. However, it applies to the layout of front and back of the 2D die: either front and back will be joined vertically or horizontally.
3.8 Diaper Bags

The diaper bag is a very complex flexible bag type. A diaper bag has a bottom seal, side gussets at the bottom (horizontal gussets at the bottom) and top gussets at the top (vertical gussets at the top) of the bag.

Diaper bags are commonly used for diapers, sanitary napkins, ....

**Note:**

Certain variants of the diaper bag die shape may not be supported by Studio Toolkit.
Settings:

- Dimensions: Width, Length, depth
- Bottom Seal.
- Package Content. See Put an Object inside the Package on page 33
- Appearance: Highlights, Rounding. See Tweaking the Substrate shading on page 35 and Setting the Rounding Value on page 36

3.9 Ponytail Bag

The Ponytail Bag is commonly used for bread and other dry food such as pasta. The bag has an open top side that is closed by a clip, resulting in the typical ponytail shape.

The image underneath shows a ponytail bag in Studio Visualizer in Adobe Illustrator. A 3D file of bread has been put inside the bag in Studio Toolkit.
Note: Because of the more complex shape of this bag, it needs a fair amount of Live Shaping.

Settings:

- Dimensions: Width, Length, Depth. The length of the bag is the distance from the bottom of the bag to the top, including the Clip Length, and Tail Length, but without the Extra Grip.

- Clip Length, Tail Length and Extra Grup. The Tail Length is the distance from the clip to the top of the tail without the Extra Grip. Very often the tail length is not the same everywhere. In that case, the longest distance is taken. The Extra Grip is an extra bit of Tail, sometimes needed for filling machines. When viewed in 2D, the Extra Grip is added on the right side of the bag.

- Package Content. See Put an Object inside the Package on page 33

- Appearance: Highlights, Rounding. See Tweaking the Substrate shading on page 35 and Setting the Rounding Value on page 36

The image underneath gives a clear view of the different settings, both in 3D and 2D.
### Tip:
You can download a 3D bread shape and some clips from **Shapes** in Adobe Illustrator. You can also use ArtPro or PackEdge.

1. Open Adobe Illustrator.
2. Choose **File > Structural Design > Open from Shapes**
3. Download the 3D shape you need. The shape appears in your Library.
4. Right-click on the shape in your Library, and choose **Get Info**
5. Go to **Parts** and choose **Export**. You can now save the file to your computer. Please add "*.zae" to the filename.
6. You can now import the 3D shape in Studio Toolkit, and position the shape relative to the bag, using the **Move and Rotate** tool.
4. Changing the appearance of the bag

There are several ways to change the appearance.

4.1 Put an Object inside the Package

If you are creating a wrapper for a candy bar, a cookie or another regular shape the bag will often look more realistic when an object is inside the bag.

**Package Content** allows you to add a solid object to be wrapped by the package, and specify its shape. You can add an object in all bag types except the Stand-Up-Pouch.

1. Select **Insert Object**

A default object with dimensions based on the shape of the bag is created and put inside the bag. A newly created Pillow Bag, Gusseted Bag and Sachet will be rotated and placed "on the floor" when you insert an object.

2. After creating the object, you can change its settings in the top section of the window. You can change the content width, length and depth.
3. Click the **Shape Select** button to select a base shape for the content. You can choose from 9 variations.

4. Depending on the shape you select, you can have one or more sliders to further fine-tune the shape.

   The bag is recreated after each dimension change.

5. Click the **Done** button or the **Settings** button to close the editing mode. The content object will become invisible.

   You can return to editing the shape by clicking the **Settings** button in the **Package Content** section.

   If you disable **Insert object**, the content object is removed from the bag. Enabling it again puts the content back in the bag using the previous dimensions.
4.2 Tweaking the Substrate shading

The flexible packaging substrate gets a realistic appearance thanks to highlights and shadows that are blended with the substrate color or the graphics.

The Highlights can be changed in the Appearance section of the Settings panel of a bag. You can choose between two highlight types from the list: Glossy or Matte.

You can use the Highlights slider to change the intensity of the highlights of the bag. Without changing the polygon mesh, all these changes merely affects the way the bag is rendered. Changes are shown instantly.

Figure 1: Example of a Glossy bag

Figure 2: The same bag but Matte:
4.3 Setting the Rounding Value

**Rounding** can be set in the Appearance section of the Settings panel of a bag. Without actually changing the polygon mesh, rounding merely affects the way the bag is rendered: roundish or crinkly. Unlike stiffness, changing the roundness of a package happens instantly.
Figure 3: Example of a bag with a low rounding value

Figure 4: The same bag with a high rounding value:
5. Live Shaping

When you interact with a real bag, it responds instantly. When you interact with a virtual bag in Studio Toolkit, your computer has to perform heavy calculations to find a new realistic looking shape. This could take a long time to complete. Instead of waiting for every shaping operation to be finished completely, Studio Toolkit shows the shaping process live and offers you the possibility to keep on interacting, even while it is still shaping. This is called Live Shaping. If computers were infinitely powerful, Live Shaping would be obsolete.

You do not have to wait for Live Shaping to finish. Simply interact with the shape, wait and see how Live Shaping reacts and as soon as you are happy with the result, you save it.

5.1 Starting and Stopping Live Shaping

When creating a new bag, a small amount of live shaping is applied to it automatically. To start the Live Shaping process, click the Live Shaping button.

At any time you can decide to stop Live Shaping. Just click the Done button. The shape will pause in its current state. To continue Live Shaping, click the Live Shaping button in the Document Window.

Using the Pauze / Resume button, you can also temporarily pause the Live Shaping. Use the S shortcut to quickly pause or resume shaping.

Note:

After Live Shaping, you can no longer change the dimensions or other parameters of the bag. By clicking Restore Shape you can undo the live shaping and make changes to the parameters possible. After that, you can redo the Live Shaping.

Note: If you Undo during live shaping, Studio Toolkit will first stop the live shaping (same as clicking the "Done" button) before undoing it. This way, you can use Redo to return to the point before the Undo.

5.2 Live Shaping and Done/Stalled

When a certain bag has reached its final form, Live Shaping will indicate this by displaying Done. The bag will start shaping again when needed, for example when adding some more air. If for some reason the bag does not Live Shape anymore but still has not reached its final form yet, Live Shaping
will display **Stalled**. In this case it is best to save the file and send it to your Esko contact person for further investigation. It is definitely not an intended state of Live Shaping.

Note that you do not have to wait until Live Shaping stops. You can stop it as soon as you find it reached a pleasing form and save the file.

**Note:** In some cases, putting the stiffness slider to zero unstalls the file.

### 5.3 Air and Liquid Content

When you create a new document of any of the three different packaging types, the bag will automatically start to fill up with air. You can compare this with a bag that is not completely airtight. It will not stop air from moving in or out of the bag. In the **Shape** section of the Window, the blue air bar will give you an indication of the actual amount of air that is currently in the bag.

You can take control over the amount of air that is put into the bag by checking the **Air** box. When checked, you actually simulate an airtight bag. Use the slider to specify how much air should be put inside the bag. As Live Shaping might need some time to catch up with the new conditions, the actual content (the blue bar) might lag behind a little.

**Note:** If you move the slider too much to the right, you might put an exaggerated amount of air in the bag and make it look overstretched.

Next to air, Studio Toolkit for Flexibles also allows you to add **Liquid**. The difference between air and liquid lies in their respective weights. As liquid is heavier than air, the liquid will be concentrated
in the lower part of the package. During Live Shaping, a bag that is filled with liquid will gradually fall down until it eventually lies on the floor.

Adding liquid is also a convenient way to simulate the shape of bags that contain bulky materials such as frozen vegetables or meatballs. If you add liquid while the Air box is checked, the total volume of the bag will increase. If you add liquid while the Air box is not checked, part of the air in the bag is simply replaced by liquid.

**Note:** The gravity effect when adding liquid is visualized quite slowly with Live Shaping. Temporarily reducing Stiffness might speed it up.

**Note:** You can also put a solid object (like a candy bar) inside the bag.

### 5.4 Setting the Stiffness Value

The Stiffness of the package can be manipulated by moving the slider in the Live Shaping section of the window. The higher the stiffness, the more the substrate will try to straighten itself. The lower the stiffness, the easier the package will 'collapse', as if it were made from a soft, thin foil.

Altering the stiffness has a direct impact on Live Shaping. The resulting shape will be re-calculated and the amount of air and liquid will be added or subtracted accordingly.

### 5.5 Working with Pullers

The Pull tool allows you to interactively change the shape of the package by creating pullers. A puller grabs a point on the package and pulls it in the desired direction. Pullers look like small needles. One end of a puller is attached to the bag, the other end is a target position fixed in space. A puller will pull the attached point on the surface of the bag towards the target position.

#### 5.5.1 Creating and Changing Pullers

1. Select the bag whose shape you want to change, in 3D view.
2. Click Live Shaping, and select the **Pull tool** or use the P shortcut to select the **Pull Tool**

   **Note:** Live Shaping is paused when you create pullers.

3. Click and hold the left mouse button at the point on the bag where you want to attach the puller.
4. Drag to place the puller's end point.
Studio Toolkit will display a green plane.

- By dragging the mouse you can place the puller's end point anywhere on that plane.
- By holding the **shift** key and dragging the mouse you can change the position of the plane itself.

Movements within the green plane determine 2 degrees of freedom of the target position of the puller (X- and Y-axis), whereas changing the position of the plane across the red line (Z-axis) determines another. Together they specify the 3D target position of the puller.

5. Once you release the mouse button, the puller is created.
Note: You can reposition existing pullers by clicking and dragging the end points to another place.

After creating a puller, convince yourself that it is oriented as you intended. Hold down the space bar, press the left mouse button and drag the mouse to inspect the pullers from different angles. If you are not happy with the result, you can either undo your change (Cmd +Z), reposition the existing puller, or delete it and start all over.

If you are happy with the position of the pullers, then restart Live Shaping to see their effect. You will notice that the rest of the bag, when not pinned down by other pullers, will also move slightly towards the target position of the puller. It is as if you would pull a certain point of the bag with your fingers.

Note: Changes caused by pullers will affect Live Shaping. The changes are not instant and have to be calculated.

5.5.2 Deleting Pullers

The puller will always be accompanied with small delete buttons. You can click these to delete the puller.
You can click the **Delete all pullers** button to remove all pullers from the bag.

5.6 Working with Fold Lines

Another powerful way to interact with the shape is using **fold lines**. Fold lines are displayed as white lines on the bag. In 2D view they are always straight. You can use fold lines to add folds or creases to a design. You can also use them to straighten a part of the bag.

### 5.6.1 Fixed Fold Lines

When creating a new bag, you will automatically get a set of fixed fold lines, depending on the packaging type that you selected. These fixed fold lines cannot be deleted, although they can be changed from hard to soft.

To see the fixed fold lines:

1. Select the bag in 3D view, or select the 2D tab for the bag.
2. Click **Live Shaping**
3. Select the **Fold Line** or use the shortcut **L**

**Note:** It can be easier to pause the Live Shaping when using the Fold Line tool.

### 5.6.2 Creating Custom Fold Lines

Apart from the fixed fold lines, you can also create your own, custom fold lines. To create a fold line:

1. Select the bag, in 3D view, or select the 2D tab for the bag.
2. Click **Live Shaping**
3. Select the **Fold Line** button or use the shortcut **L**

**Note:** It can be easier to pause the Live Shaping when using the Fold Line tool.

4. Click and drag on the bag to create a fold line.

Custom fold lines will snap to the start and end point of fold and cut lines. The cursor will change when it is getting close to such a point.
5.6.3 Deleting Custom Fold Lines

If the Fold Line tool is active, custom fold lines will be accompanied with a small delete button. You can click these to delete a fold line.

You can click the **Delete all fold lines** button to remove all fold lines from the bag.

**Note:** You cannot delete fixed fold lines

5.6.4 Hard and Soft Fold Lines

Each fold line can be set either hard or soft. To switch between hard and soft fold lines:

1. Activate the Fold Line tool or use the shortcut L during Live Shaping.
2. Hold the **option** key.
   
   You will now see small type indicators next to each fold line showing whether the line is soft or hard:
   
   - A hard fold line: 🟢
   - A soft fold line: 🟣
3. Click the fold type indicator to change the type.
Hard fold lines (A) look like a crease. These fold lines are also immune to the material stiffness. In other words, Live Shaping will not try to straighten the fold angle of a hard fold line.

Soft fold lines (B) look like a smooth bend. Like other parts of the bag, the stiffness will try to straighten the bend angle during Live Shaping.

Hard and soft fold lines will both influence the appearance, so it will affect Live Shaping due to the extra calculation time that is needed. Fold lines are also linked to the stiffness of the bag, meaning that a stiffer bag will display hard fold lines sharper than a more flexible bag.

**Tip:** To create two fold lines for the back panels, use the SHIFT key to generate a straight line up to the fixed fold line, just not touching. Touching or crossing the fixed fold lines will trigger a message saying you cannot cross them. As a consequence they will not be created.

### 5.6.5 Limitations

- You cannot draw fold lines that cross a fixed fold line. An error message will be shown.
- It’s not possible to draw folding lines on e.g. a seal.
- When drawing a fold line that crosses another custom fold line (hard or soft), that other fold line will split into two parts and/or partially disappear.
- Drawing fold lines on top of each other can result in the loss of these fold lines and will also make it impossible to create another fold line on that exact place. You can always undo this.

### 5.6.6 Using parallel Fold Lines to make a smooth bend

For certain bag types, such as a chocolate bar wrapper which contains an object that is round at the top, it could be a good idea to create some parallel fold lines to make a smooth transition around the rounded content.
5.7 Working with the Polygon Mesh

Behind every bag in Studio Toolkit for Flexibles, there is a polygon mesh. This mesh is like a skeleton of randomly shaped triangles that define how the bag can move and fold. A bag will only crease along the lines of the polygon mesh.

To obtain the best visual result, it can be very interesting to change the coarseness of the mesh. A coarse mesh (default) has a typical appearance and is also faster in Live Shaping. A fine mesh is slower in Live Shaping.

The appearance of a fine mesh can range from very smooth to very wrinkly depending on how Live Shaping makes the polygons line up. In turn, this appearance is influenced by the **Stiffness** setting in the settings bar.

To alter the polygon mesh of a bag, select it and click 'Live Shaping' in the settings panel.

During Live Shaping, click the Mesh Tool in the settings bar or use the shortcut key M.
You can see the mesh overlaid in white on top of the bag when the **Mesh** tool is active. When switching from the 3D to the 2D, the polygon mesh is also visible.
You can change the mesh

- manually, using the **Mesh** tool. See *Using the Mesh tool* on page 48
- automatically, using the **Reset Mesh** function. See *Reset the Mesh* on page 48

### 5.7.1 Using the Mesh tool

The length of the Polygon Mesh edges can also be interactively altered using the **Mesh** tool:

1. Select the bag whose shape you want to change, in 3D view.
2. Click **Live Shaping**
3. Select the **Mesh tool**

   The **Mesh Tool** works like a brush. You can
   
   - Click or drag, to add new mesh points on the bag
   - Hold down the ALT key, and click or drag to remove mesh points

### 5.7.2 Reset the Mesh

Using the **Reset Mesh** function, you can reset the Mesh, removing any manual changes, and recalculating the mesh using a **Maximum Edge Length**

Changing the Mesh can be very useful when trying to get the flexible material fit better around the content shape or when you want to obtain more detailed effects/changes on your bag, e.g. smaller dents, ...

To reset the Mesh and/or change the mesh size:

1. Select the bag whose shape you want to change, in 3D view.
2. Click **Live Shaping**
3. Select the **Mesh tool**
4. Click the **Reset Mesh** button
5. Set the **Maximum Edge Length** and click **Reset Mesh**

Changing the **Maximum Edge Length** of the triangles (polygons) from e.g. 20mm to 10mm will result in a 4 times finer mesh than before, making the package look much smoother or much more wrinkly, depending on the **stiffness** setting.

As a consequence Live Shaping will also be about 4 times slower.

**Note:** Changing the Polygon Mesh size will not result in a loss of your custom fold lines, pullers, etc.

### 5.8 Working with the Freeze tool

The **Freeze Tool** offers you the possibility to freeze certain or all parts of the package so that other user actions and Live Shaping do no longer influence it. The parts that have been frozen will remain in the same shape even when the package is being modified in other areas.

1. Select the bag whose shape you want to change.
2. Click **Live Shaping**
3. Select the **Freeze tool** in the settings bar, or use the shortcut key **F**

The **Freeze Tool** works like a brush. You can

- Click and drag, to freeze areas on the bag
- Hold down the ALT key, and click and drag to unfreeze parts
- Click **Defrost all** to unfreeze all frozen parts at once.
The bottom part of this bag has been frozen to protect it against accidental changes and unwanted interactions due to Live Shaping on other parts of the bag.
The Studio Toolkit application is a standalone application allowing to import, edit and create 3D objects, and save the object(s) as Collada file.

1. The **Zoom** buttons, allowing to change the zoom factor of the preview window. You can also change the camera view point: see *Change the Camera viewpoint* on page 54
2. **Import Into** allows to import 3D or image files. See *Import Into* on page 52
3. The **New Bag** tool, used in Studio Toolkit for Flexibles
4. The **Add Sleeve** tool, used in Studio Toolkit for Shrink sleeves
5. The **Add Label** tool, used in Studio Toolkit for Labels
6. The **Transform** tool. See *Transform the selected 3D shape(s)* on page 54
7. The **Repeat** button. See *Repeat* on page 59
8. The **Settings** pannel, allowing to change or view the parameters on the selected object
9. the **Preview** panel
10. The different **Tabs**. See *Tabs* on page 61
11. When performing some specific functions (such as Transform, ...), a settings bar is added underneath the Toolbar.
6.1 Saving and opening Collada files

When saving a file from **Studio Toolkit**, the file is saved as a Collada file, containing the shape and all printable parts.

This means the file can be opened by any application that is capable of handling Collada files, such as Studio Designer.

However, the Collada files saved by Studio Toolkit also contain native Studio Toolkit information, allowing to reopen the file in Studio Toolkit, maintaining its editability, the active tab, zoom and view factor, etc.

**Note:** When dropping a Collada file onto the Studio Toolkit application, Studio Toolkit will determine if it is a Collada file saved in Studio Toolkit or not. A native Studio Toolkit Collada file will be opened, a regular Collada file will be imported.

6.2 Import Into

Using the **Import Into** button, you can import a 3D shape into your open scene. If you already have a 3D object in your scene, the newly imported 3D shape will be placed next to it.

For more info on how to obtain a 3D file, see **Obtain a 3D shape** on page 52.

When importing a Collada file or an ArtiosCAD file, any printable parts from this file will be preserved when saving to a Collada file.

**Note:** Collada files saved by Studio Toolkit can also be opened instead of imported. In that case, the file will be reopened as it was saved, with the same active tab, zoom and view, and maintaining full editability. See **Saving and opening Collada files** on page 52.

You can also use the **Import Into** button to import an image (JPG or PNG) in a 2D tab (e.g. the "Sleeve" tab), to get a preview of this image on the corresponding 3D object. See **Using graphic files** on page 53.

**Note:** Studio Toolkit can not import .bag files. If you need to compose flexible bags or boxes saved as .bag files, we suggest you convert these to Collada files in Studio Designer first.

6.2.1 Obtain a 3D shape

There are several ways to obtain a 3D file:

- You can get a shape on Esko’s online Shapes store
6.2.2 Using graphic files

In Studio Toolkit you can import graphic files to get a preview of the result, and to assist in positioning e.g. the overlap. You can also use it to place a technical drawing on the sleeve.

Using the Import Into button, you can import an RGB JPEG or PNG file.

- If a 2D tab is selected, the image will be imported in that tab

- If an object is selected in the 3D tab, the image will be imported in the corresponding 2D tab, and this 2D tab will become active

By default, the image will be aligned with the bottom left corner of the image on the bottom left corner of the printable part. You can move the graphic by clicking and dragging the border. The border (left, right, top or bottom) or corner you clicked, will become magnetic, and snap to the borders and folding lines of the 2D shape, allowing easy alignment.

This magnetism is shown using a thick blue line.

The 3D tab will show a 3D representation of the file with the corresponding graphics on it.
6.3 Change the Camera viewpoint

You can interactively change the camera view point

1. Click and drag to rotate the camera
2. Hold the Shift key and click and drag to move the camera viewpoint
3. If another tool is active, you can
   a) Hold the Space key, and click and drag to rotate the camera
   b) Hold the Space and Shift key and click and drag to move the camera viewpoint

6.4 Transform the selected 3D shape(s)

Since you are working in a 3D environment, you can move and rotate any object based on 3 axis. Imported Collada files and OBJ files can also be scaled.
If the Transform tool is selected, you can select one of four modes in the settings bar:

- Select Simple Transform or use its shortcut T
• Click and drag the center anchorpoint or change the **Offset X** and **Z** value to move the object over the X and Z axis. Holding down the shift while dragging will constrain the movement to either only along the X or Z axis.

• Click and drag the anchor point on the circle or change the **Rotation** value to rotate the object on the Y axis. Holding down the shift while dragging will constrain rotation to multiples of 45 degrees.

• Simple Move and Rotate keeps the object aligned with the floor. However, by setting the **Distance from Floor** option in the settings bar, you can also move the object over the Y axis.

• Select ![Move](image) or use its shortcut **M**

• Click and drag any of the anchorpoints or change the **Offset X**, **Y** or **Z** value to move the object over the X, Y and Z axis.

• Select ![Rotate](image) or use its shortcut **R**
• Click and drag any of the anchorpoints or change the Rotate X, Y or Z value to rotate the object over the X, Y and Z axis. Holding down the shift while dragging will constrain rotation to multiples of 45 degrees.

Note: When moving or rotating a 3D shape, the depending parts (sleeves and labels) are moved / rotated along.

• Select Scale or use its shortcut S
• Click and drag one of the anchor points to change the size of the object, using the opposite anchor point as center of origin. If you hold down the Alt key, or if you adjust the values in the Scale width, height or depth field, the scaling is done from the 3D mid point of the object.

• By default, the Uniform option is selected, so the object is scaled uniformly in the 3 directions. Changing the value for Scale width, height or depth will change the two other values as well.

• By deselecting Uniform, you can scale the object in any direction. You can restrain the scaling to uniform by holding down the Shift key.

Note: Holding down the Shift key does not give the same result as selecting the Uniform option again: the first will only restrain the current transformation to Uniform, while reselecting Uniform will adjust the complete transformation of the object to a Uniform scaling.

The Scale tool is only available when an imported Collada file or OBJ file is selected. It is not available for Bag files, or for objects that already have a Sleeve or a Label attached in Studio Toolkit for Shrink Sleeves or Studio Toolkit for Labels.

The scale option performs a scale of the three dimensional shape of the selected object. The uniform scale is very useful to correct an object that has suffered from an incorrect unit-conversion from a 3rd party CAD system. The non-uniform scale can be powerful to fine-tune the dimensions of an imported product so that it fits into its packaging.

The scale option is not suitable for printable parts as their size affects other aspects such as the 2D drawing and the artwork mapping. A straightforward scale of a printable object in 3D would result in unwanted side-effects.
To change the size of printable objects, you should use other tools instead:

- To scale an object with a label or a shrink sleeve, first scale the container (without the label or sleeve) and then add the label or sleeve.
- To scale a flexible bag, modify its dimensions in the details panel.
- To scale a box, tray or carton, or a shape created in a third party application, go back to the application where you created it (Toolkit for Boxes, ArtiosCAD, the third party application used to create the shape).
- For Shapes models, you can order a new (scaled) variant via Esko’s 3D modeling service.

If you click and drag but not on any of the anchor points, you will change the camera position, but the object will NOT move or scale. This might be necessary to make all handles visible.

**Tip:** After rotating or scaling, you might need to align the object with the floor again. You can do so by switching to Simple Move and Rotate, and set the **Distance from floor** to zero.

### 6.5 Repeat

Using the Repeat button, you can create a simple repeat of the selected object(s).

- Enter the number of repeats you want along the X, Z and Y axis
- Enter a Gap value to add distance in between the objects
- Click Done
After the repeat, you will have multiple instances of a single object. This means making changes to one of the objects will also modify the others, while you can move and rotate the instances independently.

Note: If you have one instance selected, you can use Edit > Select all copies to select all instances.

6.6 Selecting objects

When you import or create objects in Studio Toolkit you also might need to select them. Go to the Edit menu to view the selection options.

There are several ways of selecting objects:

- Simply click on an object to select it.
- Hold SHIFT and click to select multiple objects.
- Use the Cmd-A (Mac) or Control-A (Windows) shortcut to select all the objects.
- "Select all copies" is only available when an object that is part of a repeat is selected. It will select the other instances of the repeat. Use the Cmd+Option+A (Mac) or Control+Alt+A (Windows) shortcut.
- "Invert Selection" will select all objects that are not part of the current selection.

- Simply click on an object to select it.
- Hold Shift and click to select multiple objects.
• Use the Cmd-A (Mac) or Control-A (Windows) shortcut to select all the objects.
• When an object that is part of a repeat is selected, you can use **Select all copies** to select the other instances of the repeat. You can also use the Cmd+Option+A (Mac) or Control+Alt+A (Windows) shortcut.

**Tip:** By holding the option (Mac) or alt (Windows) key and clicking on one object several times, you can select objects that are behind the selected object.

**Note:** Most selection options also work in 2D view.

---

### 6.7 Tabs

At the bottom of your Studio Toolkit window, you can see the different **Tabs**.

First is always the **3D** tab. Next to that, a 2D tab is shown for every 2D object created in Studio Toolkit: a Sleeve, a Label, a Bag, ...

Deleting an object will also delete the corresponding 2D tab. Different instances (created using **Repeat**) share the same 2D tab. In that case the 2D tab will be deleted if the last instance of the object is removed.

You can rename any 2D tab by double clicking the name and entering the new name.

**Note:** The name entered for the 2D tab will be stored as the name for the technical drawing in the collada file, and will thus be used when importing the collada file e.g. in Studio Designer.

You can switch between the 3D tab and the 2D tab of the selected object, by choosing **View > Go to 3D** or **View > Go to 2D**, or by using its shortcut Cmd-G

---

### 6.8 Measurements

Using the **Measurements** tool in the 2D drawing of a bag, shrink sleeve or label, you can add essential **measurements** to the technical drawing.

The measurements you set up are automatically recalculated if you change the dimensions or other settings of a bag. In some cases, if the changes are too drastic, some measurements might be removed.

All measurements are saved inside the Studio Toolkit file and visible when placed in e.g. Adobe Illustrator. When placed in Adobe Illustrator, the measurements are placed in a separate sub-layer of the structural design file.

---

#### 6.8.1 Adding measurements

To add new measurements:

1. Select the 2D tab in which you want to add measurements
2. Select the **New Measurement** tool

A measurement is drawn between the points of line intersections. When the **Measurement** tool is activated those points are clearly visible and light up when nearly selected.

3. Click and drag from one intersection point to another to add the measurement to your document.

---

**Note:** When measuring slanted lines, you will see either the vertical or horizontal distance. See **Slant measurements** on page 63

### 6.8.2 Setting up measurements

You can change the way measurements are shown on your document

1. Select the 2D tab in which you want to change the measurements
2. Select the measurement(s) you want to modify.

**Note:** You don't need to have the **New Measurements** tool active to select and modify a measurement.

The palette will show the settings of the selected measurement.
3. Make the changes you want

- click and drag the measurements to move them closer to or further away from the intersection points.
- for slant measurements, click and drag to rotate the measurement. See Slant measurements on page 63
- In the Measurement Text section, change the unit for the selected measurement, the number of decimals, and whether or not the units need to be shown.
- In the Text Style section you can set the text size in points. Note that the size of the arrow heads is changed accordingly.
- You can define if the text should always be horizontal, or according to the measure line. In the latter case, you can define if the text should be above, on or below the line. You can also set if the text should be positioned on the left / bottom, on the center or on the right / above.
- Click the Select All button to select all measurements at once. This allows to change the units, font size, ... for all measurements in one go.

6.8.3 Slant measurements

When measuring slant lines, or simply measuring between two points that are not on a vertical or horizontal line, the measurement will by default show either the vertical distance or the horizontal distance, whatever is the biggest value.
If you want to change what distance to show (either vertical, horizontal or slanted distance), you can do so by clicking and dragging the measurement to rotate it.

Below you see some different results for the same two intersection points.

To change the measurement units, you can open the preferences by choosing Studio Toolkit > Preferences... (Mac) or Edit > Preferences... (Windows).

In the preferences, you can set the unit to be used for Dimensions (millimeter, centimeter or inch) and for Volumes (milliliter, centiliter or US fluid Ounce).